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Every year, couples around the world celebrate their 
love and commitment through their nuptials. Our job is 
to document it in the most beautiful way possible.

- Sal Cincotta
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Shutter Magazine’s focus is on photography education.
Our goal is to provide current

insightful and in-depth educational content 
for today’s professional wedding

and portrait photographer. 
Shutter uses the latest technologies to deliver

information in a way that is relevant to our audience.

Our experienced contributors help us
create a sense of community

 and have established the magazine as one of 
the leading photography publications in the world. 

Shutter Magazine: By photographers, for photographers.

   

ABOUT THE IMAGE: In New Zealand, winter doesn’t just arrive with the first snow. It bides it’s time and comes on in waves, sometimes 

many little waves in an afternoon. Michelle and Zac got to experience this first hand as a befuddled sky first dowsed us all in brilliant 

sunshine then serenaded us with dramatic rainbows before turning the air around us into the workings of a swirling life-sized snow 

globe. It made for the perfect canvas, and these adventurous souls were the ideal muse to our artist’s hearts. Once at the top of the 

hill, we suggested they run along without a care in their hearts. As we photographed them, their laughter was filling the air around 

us. We created this image for this gorgeous couple to reflect this sky less ordinary.  

THE COVER

 

TITLE: four seasons in one day 
PHOTOGRAPHER: tinted photography 

CAMERA: sony a9 
LENS: sony 24-70mm f2.8 gm
EXPOSURE: f5.0 @ 1/1000 iso 320
LIGHTING: natural light 
MODELS: michelle and zac

WEBSITE: tintedphotography.com

TELL THEIR STORY.
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Unless you have been living under a rock, you know the entire world is dealing with Covid-19 and the aftermath 
of this has yet to be realized. Panic and desperation are challenging small business owners around the world. So 
much uncertainty. So much still to be realized as every day delivers more bad news. If you are like me, I am just 
looking for some positive news. Any glimmer of hope that things will return to normal sometime soon. 
 
As of this writing, nothing even close to that is occurring. Every day is more bad news. People are dying; brides 
are panicking, wondering if their dream wedding will occur or not; venues are panicking because with each 
passing day, they are losing tens of thousands in revenue that will never be recovered; and the list goes on and on.
 

businesses survive this pandemic, and what the future looks like for our businesses. Here are some  
real-time things we are doing at Salvatore Cincotta Photography to help put our customers at ease and prepare for  
the future. 

This is the reality. You have a contract with your customers. That has to mean something. We don’t just throw 
agreements out the window because of the pandemic. Do you understand what would happen to the entire 
economy if we did? 
 
Real talk. You have contracts with vendors that you need to adhere to. And your customers have contracts with 
you, that they need to adhere to. This is how the world works. Contracts exist for when things go wrong. Well, 
everyone, things are going wrong.
 
Now, that doesn’t mean compassion goes out the window. It doesn’t mean that you can't take each situation case 

If you own a real business and this is how you provide for your family, I'm sorry, but what in the world are you 
thinking? For me, I have staff to pay, they have bills and mortgages to pay, they have food to put in their families’ 
mouths. So, how am I being responsible if I just say “screw it”?
 
So, here is what I recommend for you and your customers. First, if they have to reschedule dates, allow them to 
move them without penalty. We have already rescheduled several weddings and other shoots, no harm no foul. 

money, now you are losing the deposit and the potential revenue they are contractually obligated to pay. 
 
Second, if you are booked on the new date, give them a full refund. I know this is not what you want to hear and 
I know you are not contractually obligated to do this, but this is that “compassion” I am telling you about. It’s not 

 
An alternate option would be to subcontract the new date so you still own the event, the post-production, the 

deposit (you keep cash in your business) and offer them the ability to apply it to a family session, etc. 
 

contracts which exist for this very reason. So, get that out of your head. 

CONTRACTS MATTER

14
  

S
h

u
tt

er
 M

ag
az

in
e 

. M
ay

 2
0

20



When Disaster Strikes: Wedding Photographer Nightmares | Sal Cincotta
16

   
S

h
u

tt
er

 M
ag

az
in

e 
. M

ay
 2

0
20

17
   

b
eh

in
d

th
es

h
u

tt
er

.c
o

m

I'm going to be honest, this event, as horrible as it is, is showing me what people are made of. I'm not talking 
about photographers, I'm talking about humans that are just paralyzed by fear and uncertainty. GET UP. GET 
OFF YOUR ASS. This will pass. Yes, of course, there are parts of the country hit harder than others, but we have 
a decision to make. It's a mental decision more than anything else. We have to decide to survive. Do you want 
your business to exist when this is all over or are you indifferent to that? If you want to survive, it ain’t gonna 
happen sitting on the couch watching the news feeling bad for yourself. There is only one way out and that’s to 
lean into this. 
 
What does that mean? It means use this downtime to do something positive for your business. Think of all the 
tasks you have been sitting on for years (guilty by the way) because you had no time. Well, now you have time 
and plenty of it. 
 
So what am I working on?
 

Website. Man am I behind on this. My blog is so behind. My images need to be updated. I'm just pissed at myself 
for letting it get this far behind. 
 
SEO.  You know we all need to relook at our search engine work and make sure our sites are ranking properly. 
 
Samples.  We just refreshed our sample albums. We ordered 8 new albums. Sure, the labs are closed, but when 
they open, I will have new albums in time for the fall bridal shows. 

In addition, check out our preview room. We took every picture off the wall and are starting from scratch. It's 
time for a complete refresh in the room. We are big believers in In-Person Sales, and what's on the walls matters. 

Editing Style Refresh. All of our styles have evolved. From the way you shoot to the way you edit, it probably 
needs to be updated to ensure we are attracting the right clients. 
 
Gear Purge. Sell your old crap!
it on new gear anyway. You know who you are. 
 
Vendor Relationships. Your vendors are panicking as well. Start reaching out and planning for collaborative 
projects you can work on together.
 
Marketing. Yeah, you know that word right? The one you suck at. Well, now is the time to focus on it. What 

before after

before after

IDLE HANDS ARE THE DEVIL'S TOOLS

be updated. I'm just pissed at myself 

sites are ranking properly. 

are closed, but when 

m scratch. It's
ls matters. 
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Sal Cincotta is an international award-winning photographer, educator, author, Canon Explorer 
Of Light and the publisher of Shutter Magazine. Sal’s success is directly tied to the education 
he received in business school. He graduated from Binghamton University, a Top 20 business 
school, and has worked for Fortune 50 companies like Procter & Gamble and Microsoft. After 
spending 10 years in corporate America, Sal left to pursue a career in photography and has 
never looked back.

salcincotta.com

Get your plan together so that the minute this thing starts to recede and people are upbeat, you will be poised to 
grow your business and get it back on track. 
 
Look, we are all in the same boat. Some worse than others, but the reality is the same for all of us. The situation 
sucks, but we will make it past this. Step back, take care of your family, and then put your focus on the thing you 
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Click here or check us out at

Why the Bug Out Bag by Salvatore?

For more information, visit www.salvatorethestore.com/bug-out-bag

The Bug Out Bag from Salvatore is the last shoulder bag you will ever need. Designed by professional wedding 

Key Features

 · Weather-resistant construction
 · Shockproof foot cushion
 · Quick-release buckle for easy access

 ·
 ·
  ·
  · 

product spotlight

with

Product Spotlight | Bug Out Bag by Salvatore

21
   

b
eh

in
d

th
es

h
u

tt
er

.c
o

m

Standard Extended
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There comes a time for any successful photographer when they have to think about growing their business. In the 
beginning, as a solo entrepreneur, you are handling the services (photography, videography), marketing, sales, 
operations, production, and communications. As your business grows, it will become very evident that no matter 
how hard of a worker you are, there will never be enough time in a day to accomplish all of the tasks required 
in your business.

This is the point in your business when you probably begin to ask yourself, “Is it time to hire some help?” When 
you get to that point, it’s usually already too late. Now I want to start by letting you all know that I understand 
your reservations about hiring employees. No matter how much money you spend on equipment in a year, it will 
probably never be close to what you invest in an employee. People are inherently expensive, and the workload 
involved in having employees is also very stressful at times.

However, no empires have ever been built by an individual, and if you want to continue to grow your business, 
you will need the help of other people.
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the tasks in your business and write them down on a piece of paper. Cross out the functions that you love to do in 
your industry. Those tasks will undoubtedly include the actual photography portion, but it may consist of other 

post-production to Evolve edits. This was a fantastic decision at the time for me because it allowed me to free 
up more time doing the things in my business that I needed to do. Because post-production is going to be your 
most time-consuming task, I recommend looking to outsource that item before hiring internal help. But I have 

The next thing that is likely bogging you down is communications. I know at the beginning of my business, I 
struggled to maintain a quick response time, which for today’s brides, is becoming more and more critical. There 
are many instances where we have received not-so-pleasant emails from failing to respond to a client email within 
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who’s going to be in charge of client communications will be the person who is in charge of the client experience. 
If you choose the wrong person, it will cost you real money. There are a few traits that you need to look for when 
hiring a studio manager. The most important one is how much they want to be there. You have to hire people 
who are looking for work for the right reasons, which means that during your interview process, you have to 
weed out the people that are just looking for something temporary and look for people that genuinely care about 
helping others.

Our current studio manager came to interview with us for a photographer position. In talking with her, I quickly 
realized that she had a strong skill set in communication, was very organized, and also had sales experience. 
While I wasn’t looking for a salesperson at the time, I knew that at some point when my studio grew, I would 

highly valuable asset to our team.

you currently have as well as what you’ll need in the immediate future. You also want to look for people who are 
looking for a career path in the photography industry. This will allow you to give them opportunities to move up 
within your company as your company grows, giving them longevity and giving you peace of mind.

 

more about processing print orders, designing albums, and retouching anything that a client purchases. Believe it 
or not, this is an incredibly time-intensive job in our business. It’s also very important to consider that the person 
who is ordering prints may tend to make mistakes at the beginning, which costs a lot of money. Therefore, it’s 

HIRING YOUR FIRST EMPLOYEES
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Now, let’s talk more about the logistics of the hiring process. Understand that everything I’m going to write to 
you here comes as a result of experience. I didn’t go to business school and never worked in corporate America, 
so I have good insight as to what is relevant in our industry as a business owner who has hired both good and bad 

set. You will see a difference in the quality of applicants between trying to hire somebody at minimum wage and 

Next, it’s essential to institute a training period and implement benchmarks that your employees have to hit 
before becoming permanent with your company. I typically will give them a small raise for completing their 
probationary period. During this training period, you have to challenge them and make sure that they can 
think critically. You will not always be able to judge an employee’s ability to work under pressure just from an 
interview itself. However, when you give them essential tasks with deadlines, you will see quickly if they are 
up to the challenge. When training a studio manager, you may want to have them make client calls and listen to 
them on the phone. It’s essential to have patience in the beginning, as they will make a lot of mistakes. However, 
the errors are not what you are testing; you are testing their ability to learn from them. If you have to retrain 

 
post-production order forms, or scheduling engagement sessions.

I’m going to go out on a limb here and say that most photographers don’t have a process manual in their business. 
If you are in that category, start making one today. I use Microsoft OneNote to store our business processes and 
can make updates to it whenever I need to. When we hire a new employee, we provide them with the process 

questions you have to answer when training a new employee.

YOU HIRED EMPLOYEES. NOW WHAT?
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Michael Anthony is the owner of Michael Anthony Studios, a wedding photography studio based 
in Los Angeles. He has won multiple awards in international image competition for his creative 
use of light, storytelling and environmental portraiture. The five-member team at Michael 
Anthony Studios photographs around 60 weddings and over 200 portrait sessions a year.

michaelanthonyphotography.com

LEARN MORE.
youtube.com/btsShutterMagazine
Click here or check us out at
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The last thing that I want to go over before closing out this article is how to build an environment that encourages 
a productive team. You will likely be hiring creatives because that is who will be attracted to your job ads. That 
means that you have to promote their use of creativity in your business. As an owner, you should always be open 
to ideas from your team and implement strategies with guidance from the people who are working directly on 
those issues. For instance, if I’m doing a particular pose that clients do not tend to purchase in the salesroom, 
then I need to be open to listening to my salesperson when she says we need to look at a different strategy here. 
By listening to your team and implementing their ideas, you are helping them to become part of your business. 
This is essential for creating longevity in your business and having happy employees. Happy employees will 
be productive, and productive employees will make you more money. Other things you can do are implement 

on a project by yourself, assign a member of your team to be working on it with you. That’ll allow you to 
collaborate with them because two minds are almost always better than one. Surround yourself with a fantastic 
team, and that will pay you back in dividends even though employees are incredibly expensive.

If you implement the strategies that I laid out above, you will build a reliable team that will put you on the right 

Learn more at

sigmaphoto.com

All lenses protected by a 

4-Year USA Warranty

Together, these two are

crafted to capture more.

14-24mm F2.8 DG DN 

24-70mm F2.8 DG DN

The Powerful
Mirrorless Duo

Art

Available in Sony E-Mount and L-Mount

are

more.

G DN

DG DN

t and L-Mount
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LEARN MORE.
youtube.com/btsShutterMagazine
Click here or check us out at

Why the Sigma 85mm 1.4 DG HSM Art Lens?

For more information, visit www.sigmaphoto.com/85mm-f14-dg-hsm-a

 ·
 ·  
 ·
 ·

product spotlight

with

Product Spotlight | Sigma 85mm 1.4 DG HSM Art Lens
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A Simple Way to Control Color for the Professional Photographer | Douglas Weittenhiller 
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A Simple Way to Control Color for the Professional Photographer | Douglas Weittenhiller 

Understanding color output is an essential part 
of professional photography. However, there 
are limits to what you can control. You can’t 
determine how images look on people’s devices. 
However, you can ensure that you’re giving 
them the best chance to view your work in the 
way you intended. More importantly, having 

the very best print products for your clients who 
love sharing your beautiful work digitally and 
with prints.

There is not, of course, an easy answer to what 
is best. While there are color standards—sRGB, 
Pantone, Munsell—there is a mixed application 
of those standards, which creates inconsistencies 
across screens, printers, labs, software, and even 
in the implementation of them. This variation 
is apparent when prints are produced with 

all claiming to be using the same color system.

This article comes nowhere near exhausting all 
the permutations of color control options, but 
rather it seeks to create a template that works 
for many professional photographers.* There 
are three domains where you have the most 
immediate control: your working color space, 
the calibration of your screen, and the setup of 
your printing labs.

* I do not pretend to be a guru of color control. 
I’m presenting ideas that I have found produce 
consistent results for client work. For a more 
comprehensive resource, I strongly encourage 
taking a course with Eric Joseph, Senior VP at 
Freestyle Photographic. (www.freestylephoto.biz)
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A Simple Way to Control Color for the Professional Photographer | Douglas Weittenhiller 

WORKING COLOR SPACE

screen color of your monitor, tablet, or phone is a mixture of red, green, and blue phosphorescence (RGB) and 
the print color from your labs or own devices is a mixture of cyan, magenta, yellow, and black (CMYK). In the 
early days of computer-generated print press, there lacked a way for the screen and print color to even talk to 
each other, resulting in enormous problems for producing consistent prints (https://99designs.com/blog/tips/

with mixed results. It can be a bit like Google translating song lyrics from one language and then back again, 
often to hilarious effects.

The simplest working solution is to have consistency in your color working space across all devices. You can 
link your camera, software, and monitor (more on this later) to the same color space. Two standard screen color 
spaces for photographers are sRGB and Adobe RBG.

Adobe RGB, as the name implies, is Adobe’s attempt to support more colors that should lead to images that 
more closely resemble what the human eye can perceive. It’s gaining in popularity across all devices but is 
still not universal across all mediums (https://fstoppers.com/pictures/adobergb-vs-srgb-3167). While it’s a 

 
straightforward process.

compared to Adobe RGB, its ubiquity translates to a universal color system. In almost all practical applications, 
this should be the preferred color space for photographers seeking a no-fuss setup with color. Almost every 
screen, printer, lab, and camera supports it and can accurately display it.

An argument can be made for either color space. However, in the mindset of what is the most straightforward, 
sRBG is the better choice since it displays the same online and across all devices, it can be easily calibrated, and 
it’s supported by most print labs.

camera settings

photoshop

lightroom
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A Simple Way to Control Color for the Professional Photographer | Douglas Weittenhiller 

SCREEN CALIBRATION

Out of the box, your computer monitor is set for the best viewing experience. Manufacturers try to make  
time-of-day considerations with auto-dimming features or improve viewing experiences with glossy displays 
that create pseudo-richer contrast. Screen technology is continually improving, from older and bulky CRT  
tube-style monitors to newer OLED and Wide Gamut screens. While some purists argue that only properly 
calibrated CRT screens can provide accurate color, most professional photographers can produce lovely and 
acceptably accurate colors from almost any modern screen. The key is to purchase and use a screen calibrator.

Many options exist, such as Datacolor’s Spyder5 (www.datacolor.com/photography-design/s5-welcome/) or 

vastly superior to leaving this to chance. 

Calibrators are simple to use and generally require little maintenance. Here again, the case can be made to 
implement the same color spaces you used before. With light standardization being challenging (https://sciencing.
com/how-to-convert-lux-to-candela-12751786.html), the output of screen brightness and the amount of ambient 

an optimal working environment free from color casts and hotspots as well as consistent color spaces while 
producing imagery.

Remembering what was essential from the last section, calibrate your screen to be in the same color space as your 
camera and software to create seamless consistency. Also, editing in the same amount and type of ambient light 
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A Simple Way to Control Color for the Professional Photographer | Douglas Weittenhiller 

PREPPING FILES FOR YOUR PRINT LAB

Every press lab attempts to match to the intended color of the artist. Most have given up on demanding a 
 

color-matching is where most photographers with inconsistent prints can improve.

Labs such as Millers (www.millerslab.com), ACI Lab (https://www.acilab.com), and Simply Color  
(https://simplycolorlab.com) provide support for photographers to calibrate their setup to what the lab uses. 

There are, of course, exceptions. Bay Photo, for example, prefers Adobe RGB for some print types (https://support.

connect with their preferred lab (or labs) to export edited images destined for prints in the correct color space.
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A Simple Way to Control Color for the Professional Photographer | Douglas Weittenhiller 

Douglas Weittenhiller accidentally became a photographer when his wife’s growing hobby 
forced him to quit his real job. Thankfully, he didn’t completely suck. With his newfound love of 
not having a boss (other than his wife), he applied his nerdy background in science to learning 
everything about the craft. He’s at his best with people who enjoy a good laugh, a tasty beverage, 
and an interest in the world around them.

twigandolive.com

CONCLUSION

The best news for the working professional photographer (and even the amateur) is that implementing these 
steps is straightforward and relatively simple. The longest time spent is waiting for your calibrator to arrive. The 

the output to the labs of choice—can be done once and refreshed annually. The results are immediate, and the 
impact of controlling color across your production pipeline is rewarding.
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The Minimalist Videographer: Why Gear Isn’t Everything | Rob Adams

with Rob Adams
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The Minimalist Videographer: Why Gear Isn’t Everything | Rob Adams

More than 10 years ago, when wedding cinematography was elevated to a whole other level with the introduction 

time) to the following:

3 DSLRs, sometimes 4
8 lenses

4 audio devices

3 monopods
3 tripods
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The Minimalist Videographer: Why Gear Isn’t Everything | Rob Adams

 

SO HERE’S WHAT I ULTIMATELY CUT OUT FROM MY GEAR KIT:
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The Minimalist Videographer: Why Gear Isn’t Everything | Rob Adams

Rob Adams is a veteran wedding filmmaker and educator. During his 22 years filming weddings 
he has helped to define modern wedding storytelling with his blending of visuals and spoken 
dialogue. He has been a frequent contributor to Shutter Magazine and has spoken at various 
photo and video conferences around the globe.

robadamsfilms.com

LEARN MORE.
youtube.com/btsShutterMagazine
Click here or check us out at

SIGN UP 
levelupsal.com/sign-up

levelup.indd   2 4/10/20   9:40 AM



55
   

b
eh

in
d

th
es

h
u

tt
er

.c
o

m

How to Get Consistent Color Between Cameras in Lightroom Classic | Dustin Lucas
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How to Get Consistent Color Between Cameras in Lightroom Classic | Dustin Lucas

RAW VS. ADOBE DNG & CAMERA PROFILES 
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How to Get Consistent Color Between Cameras in Lightroom Classic | Dustin Lucas

CAMERA CALIBRATION 
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How to Get Consistent Color Between Cameras in Lightroom Classic | Dustin Lucas
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How to Get Consistent Color Between Cameras in Lightroom Classic | Dustin Lucas

THE RESULTS

LEARN MORE.
youtube.com/btsShutterMagazine
Click here or check us out at

Dustin Lucas is a full-time photographer and educator focused on the wedding industry and the 
academic world. After achieving his Master of Fine Arts degree, a career opportunity opened 
once he began working with Evolve Edits. Through teaching photography classes and writing 
about photography, Dustin continues to expand his influence on art and business throughout 
the industry.

evolveedits.com
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How to Build Your Photography Website with WordPress in 2020 | Alicia Simpson

There are tons of platforms out there that photographers can use to build a website. At one point or another, you 
probably heard that Wordpress is the “best” for SEO. Maybe you tried to get started on a site and promptly began 
to pull your hair out from frustration. What theme should you pick? Why doesn’t it look like the screenshots you 
saw? How do you get a decent looking gallery? How do you make it load faster? Shit, you activated a new plugin 
to help and it broke everything.

Wordpress is a platform with the power to build almost anything you want, but all that freedom makes it really 
tricky to navigate. Until I found the right tools through a lot of trial and error and crashed sites, I found it 
frustrating as well (in fact, as I write this, we’re dealing with the headache of switching the ShutterFest site to a 
new server). In this series, I want to save you all those headaches and show you the entire process of building a 
Wordpress site for your photography business, from beginning to end. 

In this article, I’ll touch on hosting, and we’ll get our theme and basic styles set up.

CHOOSING THE RIGHT HOSTING

If you take one thing away from this section, it should be this: don’t cheap out on hosting. Choosing a decent 
host is key to making sure your website is as fast as possible. You can optimize your site all day long, but if you 
have a slow host, you can only get so far.

We use Liquid Web for our hosting. I’m no server expert, so I don’t want to get too into this, but here are some 
things to look for:

• Can you get a dedicated server? Basically, this means that the only website on your server is yours, and 

• Does the host have a “managed WordPress” option? This will make things way easier on you and is well 

and automatic updates. Sometimes they can even help you migrate your website to their system.

• How is their support? Do they have phone and live chat, or just email? Are they available at any time?

PICKING A THEME

Okay, you’ve got a good host and WordPress 
is installed. The next thing to do is install a 
theme! I’m going to take a different approach 
than most people and tell you not to mess 

theme” on Envato. Don’t even go look. What 
you really need out of a theme is something 
minimal and fast that has a full-width layout 
option, a good looking header, footer, and blog. 
Our page builder is going to handle everything 
else. Yes, even the galleries.

My two favorite themes are OceanWP and GeneratePress. I think OceanWP is the prettiest out of the box, so I’m 
going to go with that. On your WordPress dashboard, go to Appearance > Themes, click the Add New button at 
the top and search OceanWP in the search box. When it comes up, hover over the thumbnail and click Install, 
then Activate.

WP Dashboard

Find OceanWP
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How to Build Your Photography Website with WordPress in 2020 | Alicia Simpson

CUSTOMIZING THE THEME

Go to Appearance > Customize. This opens up the theme customizer, and we are ready to get going. On the  
left-hand side of the screen, there will be a list of sections on the site you can control. I like to go straight down 
the list to make sure I hit everything. 

SITE IDENTITY

First up is Site Identity. This is important for SEO and social media—it shows up at the end of every page 
and link shared. For Sal’s site, we made the site title the keyword that matters most to us—St. Louis Wedding 
Photographer—and set the business name as the tagline. In this section, you can upload a 512x512 site icon as 
well. This is also called a favicon. It’s the teeny tiny icon that shows up next to your site name in a browser tab, 
so keep it simple. 

Pro Tip: Hit the Publish button at the top after you’re done with each section to push your changes live.

At this point, you’re probably seeing a lot of 
notices cluttering the top of your screen. Go 
ahead and dismiss all of them.

Now, it’s time to get started!

Next, we’re going to install a plugin called Ocean Extra that adds some, well, extra functions to our theme. Go 
to Plugins > Add New, then search for and install Ocean Extra.

Blank Plugins

Install Ocean Extra

Activate

Notices

Site Identity

Site Identity Display
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How to Build Your Photography Website with WordPress in 2020 | Alicia Simpson

MENU

Now let’s make our menu. In the Menu section, click Create 
New Menu. Give it a name, like Main Nav, and check Main so 
that it displays at the top of your page. Click Next, and a button 
called Add Items will show up. When you click it, you’ll be 
able to start making new pages and adding existing pages by 
clicking the plus button to the left of the page you want to add.

Create New Menu

Name Menu Add things to Menu

I’m going to add Home, and create pages called About, Weddings, Seniors, Blog, and Contact. Now we’ve got 
a good menu with a search feature, too.

Final Menu

HOME PAGE

I know I said I go straight down the page, but as it turns out, I lied. I’m going to skip the Widgets section and go 
to Homepage Settings. This is an easy one. Set your homepage to display a static page (set it to Sample Page) 
and set your posts page to Blog. 

GENERAL OPTIONS

Under General Options > General Styling, set your brand colors. Pick 
something darker for your primary color, and a lighter (but still visible) 
color for the hover and border colors. Leave the background color as 
white, and set your link colors to something that will stand out from the 
text. Don’t worry if you’re a little unsure of what it’s all going to look 
like—we can always change these later. 

colors
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How to Build Your Photography Website with WordPress in 2020 | Alicia Simpson

In General Options > General Settings, we’ll set our layout styles. I like to keep the main container at 1200px, and 
keep the content and sidebar widths as-is too. For Page layout, I select 100% full width, so that any backgrounds 
we make in our page builder can stretch as far as possible. Leave everything else as-is. 

In General Options > Page Title, set the visibility to Hide on Tablet & Mobile, leave the heading tag as H1, and 
set the style to Hidden. 

In the Scroll to Top section, I’m going to uncheck the scroll up button. It’s nice for sites with lots of information, 
but I don’t think we need it here. If you do want one, this is where you would customize the icon and color of 
the button.

Skip Pagination for now, and we’ll come back to it when we set up our blog. Next is Typography.

TYPOGRAPHY

I won’t go into detail on all these 
settings—but you will need to 
hit Body, All Headings, Heading  
1—Heading 4, Main Menu, and 
Mobile Menu for now. 

(fonts.google.com) that matches 
your brand, has upper and lowercase 
letters, and has at least 3 weights. 
That way you can have headings that 
are bold and light for contrast, and an 
in-between weight for regular text.

Set the font family you chose in the 
Body section. By setting the font in 
this section, it will carry through to 
all the other typography settings, 
and you won’t have to waste time 
selecting it in each section. I’ll also 
set the font color here, matching it to 
my primary color from the General 
Options section.

A good size for body and main menu 
text is 16px. For headings, I like to 
start with Heading 1’s at 40px, and 
go down from there for headings 
2—4. Again, we can override or 
come back and adjust these sizes 
when we start building the pages. 
If you want all your headings to be 
uppercase, you can set that in the All  
Headings section. 

layouts

Body font
Headings

Mobile Menu

Pro Tip: Use the device buttons at the bottom of the page to preview your site and see how your mobile menu 
settings look.
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How to Build Your Photography Website with WordPress in 2020 | Alicia Simpson

TOP BAR

Next, go in to the Top Bar section. This is a great spot for 
social media links and a phone number. In Top Bar > General, 
you can customize the colors and change which side the 
social media links are on. I’m going to leave all that alone 
and go to content. I want to add a phone number here. If you 
want to make it clickable (so people can tap to call on their 
phones), you will have to add a tiny bit of HTML code: <a 
href=”tel:800-555-5555”>800-555-5555</a>

In Top Bar > Social, add links to your social media pages and 
set the colors of the icons. 

Top Bar Phone

Top Bar Social

HEADER

Now, jump back to the Header section, and go to Logo. Click Select Logo and upload a high-res logo. The 

wide like I did, you can safely skip the Retina logo option. After you upload, it will give you the option to crop 
or skip cropping. Then you can set the Max Width of your logo. Scale it until you’re happy with the way it looks. 

SEO Tip: Name your image according to the top keyword you want to rank for, and add alt text to the image 
when you upload.

Go to Header > General to pick a header style. Minimal is the default, but you can go transparent, stacked, full 

The only other thing you might have to edit is in Header > Mobile Menu. If 
you have a lot of pages or long page names that can’t be shortened, you can 
adjust the point where your normal header becomes your mobile header (a 
hamburger icon people click to see all the items). You can also edit all the 
colors of your mobile menu here. 

 Logo upload

 Logo size

 Header Minimal

 Header Vertical

 Menu Breakpoints

 Header Full Screen
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How to Build Your Photography Website with WordPress in 2020 | Alicia Simpson

BLOG

Next, navigate to the Blog settings section, and click Blog on your menu in the 
website preview so you can see how your changes look. On the left side of the 
screen, go to Blog > Blog Entries. You’ll see options for the layout of the page. 
You can have a sidebar on the left, right, both, or no sidebar. I don’t recommend 
100% full width, because it leaves no breathing room on the page. I’m going to 
leave the right sidebar layout selected.

 Blog Settings

 Blog Entry

You can reorder how the content shows up on mobile. I am going to select Sidebar/Content so that the search 
bar can be at the top on mobile. Leave the heading tag as H2. H1 is an option, but best practice is to only have 
one H1 per page. 

Next, you can set the style of each blog post. I’ll go with Large Image and set the length of the excerpt to 150. 
Then you can set the visibility and order of the elements in each blog post. As you can see in the image, I placed 
my title and meta (a fancy word for the date and category) above the featured image, followed by the content (a 
fancy word for the excerpt) and Read More button. I also turned off the visibility of the author and comments, 
because there’s only one author and comments are disabled. 

Now, click in to the sample blog post on the right, and go to Blog > Single Post on the left. This is where you 
could design the layout of your posts, but we’re going to have some fun later and use our page builder for  
that instead.  

 Blog Element Position  Blog Element Position Example
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How to Build Your Photography Website with WordPress in 2020 | Alicia Simpson

If you’ve ever emailed support@behindtheshutter.com, you’ve probably talked to Alicia Simpson. 
In addition to part time tech support, Alicia is a Senior Graphic Designer at Cincotta & Co, 
and has worked for Sal for the past four years. She designs marketing materials and websites 
for Behind the Shutter, Evolve, ShutterFest, Level Up and any other brands Sal can come up 
with. She is also heavily involved in the graphic, trade show and website designs for Creative  
Cinc clients.

behindtheshutter.com

FOOTER WIDGETS, FOOTER BOTTOM, & SIDEBAR

In Footer Widgets, un-check the checkbox next to Enable Footer Widgets to get rid of that section. Now, 
go to Footer Bottom and in the Copyright box, enter your NAP: name, address, and phone number. This 
is incredibly important for SEO if you want to show up in local search results like “Photography in [Your 
City].” It’s also good to include a contact email here. This is another section you’ll have to include a little 
bit of HTML code in order to create links, but don’t worry, I got you. To create a telephone link, type <a 
href=”tel:800-851-0520”>800-851-0520</a> (replace the two phone numbers with your own). To create a link 
that opens up a new email, type <a href=”mailto:team@cincottaemail.com”>TEAM@CINCOTTAEMAIL.
COM</a> (replace the two email addresses with your own). Set your padding and colors, and you’re good to go!

The last thing we need to do is set up our blog sidebar, in the Widgets section we skipped over way back at the 
beginning. Go to Widgets > Default Sidebar and remove the Recent Comments widget. I like to add Categories 
so people can browse by wedding, engagement, etc. If you’re a Mailchimp user, OceanWP also includes a 
Mailchimp widget you can use to collect emails—you’ll just have to follow the directions to set it up. 

Click Publish one last time, and you’re done!

ACHIEVEMENT UNLOCKED: WORDPRESS THEMES 101

Well, friends, we did it! It’s not the most exciting thing out there (yet), but it’s got a fast theme, a nice header and 
footer, and a blank canvas for us to start designing on. I hope this helped you navigate the basics of setting up a 
WordPress site and saved you some headaches. Be sure to check out my next article, where we’ll get into the fun 
stuff and start designing pages and galleries!

 disable footer widgets

 footer bottom

remove comment widget

Mailchimp widget
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5 Ways to Make an Extra $2K Per Client | Makayla Jade

with Makayla Jade
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5 Ways to Make an Extra $2K Per Client | Makayla Jade

As a wedding photographer with a young family, my weekends are sacred to me. I always knew I never wanted to 
be “high volume,” but of course I wanted to make as much as possible per client to scale my business. Over the 
years I’ve learned a number of ways you can increase your client accounts while receiving raving reviews and 
not giving up more weekends! Hint: if your clients are spending more with you, it doesn’t mean they’re unhappy 
clients. The experience and value you provide just needs to match the price. 
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1:1 ORDERING APPOINTMENTS, VIRTUAL OR IN-PERSON SALES 

Even if you don’t have a studio or a place to meet with your clients in person, meeting “virtually” 1:1 after 
each photographic experience is a great way to help guide your clients through the image selection process, 
show them all the product offerings, and ease them through the decision making process. While just sending 
out a gallery may seem convenient and easy, it can lead to the client becoming overwhelmed by options and 
pushing off making any decision. Most consumers don’t know the difference between lustre or deep matte, and 
they aren’t familiar with what frame sizes would work well above a couch or an accent wall. This is where our 
guidance can be of service to them. It’s also easy for people to be more self conscious or worried about the way 
they look in the photos when they are viewing them by themselves behind a computer screen. By helping the 

excited about their photos and all the ways they can showcase them.
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5 Ways to Make an Extra $2K Per Client | Makayla Jade

ENGAGEMENT SESSION SALES

missing out on a lot of additional revenue. I used to charge $950 for an engagement session with the digital 

would add it on, but maybe 15 or so each year, which meant roughly an additional $14,250 in revenue. What I 
realized, however, was the couples I did engagement sessions with I felt more connected to, comfortable with, 
and was more excited for their wedding day when the time came. I wanted to do more engagement sessions 
but I didn’t want to decrease the price. I decided I would just build the session into my base collection as a 
“complimentary” add on, meaning everyone got it. Because it was complimentary they could remove it, but 
wouldn’t get any money off the collection price. I also explained that the pre-session planning, photographic 
time, and 1:1 ordering appointment was included, but any prints or digitals from the session would have to be 
purchased separately. By building effective print collections and pricing my digitals appropriately, my average 
post-engagement session sale was around $2,600 that year (engagement album, wall art, prints for parents, save 
the dates, digital downloads). $2,600 x 30 couples = $78,000 in additional revenue just from engagement sales. 
By including the engagement session for free, it made it a no brainer for every couple to do it. From there, I was 
able to build trust and credibility plus hype them up about prints and albums and all the things they could do 
with their engagement photos, so by the time we did our 1:1 ordering appointment, they were actually excited 

know exactly what to expect! 
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5 Ways to Make an Extra $2K Per Client | Makayla Jade

PRE-DESIGN EVERYTHING

I hate the idea of feeling pushy or salesy, so when I got started with virtual/in-person sales I would let the clients 
pick the images they wanted for their album, then I would design it and send them an online proof. Big mistake. 
The problems with that were:

1. It would take the client forever to select the images because they loved them all and it was so 
overwhelming to choose.

2. Oftentimes the images they picked didn’t tell a full story… they might choose one image from the cake 
cutting and 27 sunset shots. I found myself with layouts and designs that didn’t make sense. Some pages 
felt redundant and other pages felt like something was missing. 

3. If the album in their collection included 65 images, most people would just select 65 images which 
meant $0 in upgrades, and now I have to order a $400 album.

4. They focused only on the album because that was included in their collection, and never purchased 
anything else like wall art or gifts for parents. By pre-designing an album, wall art, and thank you cards 
for your clients it does a few things:

a. Once they see the pre-design or “mock-up,” they’re able to visualize it and fall in love with it, 
meaning it’s a lot harder for them to say no. This means more beautiful things in their life and more 
sales for you.

b. It’s a lot harder for people to remove photos than it is to add photos. By intentionally  
over-designing the album to 100+ pages, you instantly open up the opportunity to upgrade. It will 

let’s be honest, we say over-designed, but these are their photos. It won’t feel that way to them. Also, 
I’ve found that every couple is different and prioritizes different parts of the day. Some couples 

providing a robust design covering every part of the day, I’m giving the client the opportunity to see 
everything and then they have the option to choose versus me choosing what should be excluded 
from the album. 

c. The story feels full and beautiful because you (as the expert) designed it in a visually appealing,  
well-balanced way. 

d. If they weren’t initially interested in wall art but you show them a beautiful collection of their 
most meaningful moments, now they may consider that as an upgrade. Same goes for other add-ons 
like thank you cards.

3
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5 Ways to Make an Extra $2K Per Client | Makayla Jade

REACH OUT TO PARENTS OF THE BRIDE/GROOM

It’s a big day for the parents of the bride and groom as well. While I used to think “they’ll reach out if they want 
something” I’ve learned there’s a lot of additional revenue that can be earned if you establish a relationship with 
the parents from the beginning. In the initial consultation, you can ask your couple about how involved their 
parents are in the planning process to get a sense for if it would be appropriate to reach out or not. From there, we 

agreement with us. We let both the clients and the parents know that while the couple is our main priority, we 
also understand that this is a big day for mom and dad as well, and we would like the opportunity to get to know 
them and their family better so we can serve them in the best way possible. After obtaining the parents’ contact 
info from the couple, we send out an introductory email to all involved parents introducing ourselves and letting 
them know we are here to help. Then, about 3-6 months before the wedding we will reach out again and let them 
know that we’re in the process of building out the timeline and family photo combinations with the couple and 

a call with us. On this call we will answer any questions they have and ask them if they’d like to pre-purchase a 
parent album, wall art piece, rehearsal dinner coverage, or anything additional we feel may be of service to them. 

between $2,500-4,500 on parent albums, wall art, or additional upgrades. At 30 weddings a year, that’s 8 parents’ 
accounts spending on average $3,500. An extra $28,000 sounds nice right?
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5 Ways to Make an Extra $2K Per Client | Makayla Jade

Makayla Jade, co-founder of The Harris Company, developed a brand distinguished by 
providing an elevated photo and cinema client experience, propelling the company by 
appealing to a niche clientele that places a high value on printed products and photographic 
art. Makayla Jade has been featured in major industry magazines and conferences, sharing 
techniques involving business systems, brand marketing, and a unique approach to educating 
clients about the importance of print and investing in heirlooms. Makayla currently serves 
on the Board of Directors for Professional Photographers of America, and was awarded the 
2019 Best in Business: 40 under 40 award of the capital region, New York. Her proudest 
accomplishments are snagging the best looking, most supportive husband out there and 
making it through daily life with her 2 crazy kiddos.

theharrisco.com

SAME DAY SLIDESHOWS

The thought of producing a slideshow of images the day of the wedding can seem pretty terrifying. Keep in 
mind, it doesn’t have to be perfect—you’re just going for impact here. This is one of the most effective ways to 
market your business to your ideal clients and get add-on print sales from wedding guests. Here’s how to make 
this happen:

1. Set up the wedding gallery before the wedding day (feel free to add in an engagement photo for the 
cover image). 

3. During cocktail hour or another “downtime” during the wedding day, send your second shooter to 
shoot detail shots or group photos while you select 50-100 of your favorite photos (or vice versa). 
4. Throw a quick preset/exposure adjustment on these images and export.
5. Use a digital picture frame to display the photos near the bar for people to watch while they wait for 
their drink.
6. Stick a business card holder on the picture frame and use the business cards with the URL on the back 
to send guests back to your website to view the gallery when it’s ready.
7. Capture their emails when they enter the gallery, send them an announcement when the images are 
ready with a discount off loose prints in the gallery, and then add them to your email newsletter. 

Maybe not every one of these will work for your business and I don’t want to downplay the amount of work 
involved. Each of these will take hard work. So start by implementing 1-2 of these ideas to help increase your 
client accounts and boost your revenue this year, and then come back to try new ideas.  
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5 Ways to Use Off-Camera Light on a Wedding Day | Justin Haugen

Weddings are commonly acknowledged as one of the toughest 
specialties of photography. You’re confronted with rapidly changing 
lighting conditions and are tasked with documenting authentic 
moments artistically, while under major time constraints. You’ve 

realize it’s time to add something new to your toolkit that is going to 
separate your images from the competition and help you overcome 

you 5 techniques to help take your wedding photography to the  
next level.

in some form with your average speedlight. We’re living in the 
golden era of off-camera lighting options and we’ve come a long 

help of an assistant. Not only will they help you wrangle gear you’re 

light pattern will transition to darkness as it moves away from their 

pattern will appear.
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5 Ways to Use Off-Camera Light on a Wedding Day | Justin Haugen

SHOOTING DETAILS

When performing macro photography for detail shots of the rings, the light placement is very close to your 
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5 Ways to Use Off-Camera Light on a Wedding Day | Justin Haugen

REFERENCE LIGHTING

that the light was there all along.

from the sign, much too far to get the actual glow of neon to reach them in this scenario. With 
considerate placement and gel use, we can still reference the light in the scene as a critical part of the  
creative result.
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SMOKE AND SPRAY

all make for some intriguing effects.
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5 Ways to Use Off-Camera Light on a Wedding Day | Justin Haugen

SILHOUETTE ANYWHERE

silhouette anywhere.

inch of the mansion.

Pro Tip: Michael Anthony of Michael Anthony Photography told me his secret to getting these types of photos 

With a little guidance on positioning, you can get a perfect silhouette anywhere!
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5 Ways to Use Off-Camera Light on a Wedding Day | Justin Haugen

HIDING LIGHT IN PLAIN SIGHT

something special, even if it means stepping out of your comfort zone with a little post-processing.

approach is that we simply don’t even hide the light at all. With a little light-handed cloning and healing work in 

with this process in mind and you’ll minimize the post-process work you loathe.
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5 Ways to Use Off-Camera Light on a Wedding Day | Justin Haugen

Justin is a Wedding and Portrait photographer currently living in Tucson, Arizona. Starting his 
career photographing motorsports and feature cars for automotive publications, it wasn’t long 
before he found his passion in connecting with people and capturing their stories on camera. 
His current obsession is teaching photographers how to use off-camera lighting and will be 
teaching at ShutterFest 2020. Justin is sponsored by Tamron USA, MagMod, and HoldFast Gear.

justinhaugen.com

Join us
PPA.com/JoinUs

Build Your  
Photography Business

Everything you need–everything photography–is at PPA

Equipment Insurance & Data Loss Protection

Community & Education

Sales & Marketing Resources

CONCLUSION

Now that you’ve read 5 different ways to approach your off-camera lighting on a wedding day, it’s imperative 

planned practice session with one or two people. Some of these concepts are easier to pull off than others, and 

showed them on their wedding day.
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5 Tips for a Successful Wedding | Justin Yoder

There are a lot of elements that go into making a wedding successful from a photographer’s perspective. A lot of 
times we feel that if the client is happy, then mission accomplished! But if that’s your only gauge of whether a 
wedding was successful or not, then there’s a lot you’re missing out on. I want to help challenge you to look at 
other aspects of a successful wedding day, from before you even book a client to getting bookings from guests at 

To me, this should be obvious, but I’m amazed at how many wedding photographers don’t do this. If you are 

IPS (I highly recommend it), I still recommend meeting your prospective clients before sending out a contract. 

quickly as possible. But consider this: if you’re booking clients that make you hate photography, that isn’t a 
healthy way to run your business.

If your prospective client doesn’t want to meet with you, explain to them that their photographer will probably 
be spending at least eight hours with them and their families on a wedding. Encourage them that no matter who 

importantly, start building a good relationship with them. After all, if they do book you, there’s a good chance 
you will be doing their engagement session, bridal session, wedding, and IPS session and this is the foundation 
for making all those connection points go smoothly and build trust.
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1. MEET WITH YOUR PROSPECTIVE CLIENT BEFORE YOU BOOK THEM
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2. DO A SHOOT WITH YOUR COUPLE BEFORE THE WEDDING DAY

relieve stress for the couple. If you have never met before the wedding day and you’re walking in as a stranger 
who is now trying to give them directions while attempting to capture their day beautifully, their natural stress 
can easily shift to aggravation with you. However, if you have met with them before the booking and had a fun 
shoot with them before the wedding, you are a safe, comfortable, familiar face to them. They know you know 
what you’re doing and that you can be trusted. This helps relieve a lot of stress for the couple, which translates 
into them being easier—and more fun—to work with.

If they don’t want to do a shoot beforehand, tell them you will do one for them for free. This is time only—they 

see how you work, and that brings so much value and comfort to a couple on their wedding day.
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5 Tips for a Successful Wedding | Justin Yoder

3. SIGNATURE SHOTS TAKE TIME

direction while things are happening, but it’s usually not a “Let’s stop everything in its tracks for a photo!” 
situation. However, if you look at my website, what draws my clients in and what they expect of me are those 
impactful, dramatic images which would make beautiful art for their homes. To be able to accomplish this, I set 
the expectation at our consultation that these shots take time. I usually tell the client and the planner that I want 

unfamiliar venue, I will arrive early to look around for the location for these shots, so I know exactly where I’m 
going to do them after family photos. I have my assistant get the lighting all set up and ready so there’s little to 

if the planner cuts us off early I still have the signature image.
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At a wedding there are a lot of eyes on you. The way you treat family and guests and how you present yourself 
can mean the difference between booking future clients from a wedding or not. I have actually had four sisters 
that all hired me for their weddings because they saw how I worked at each wedding and loved my style. I also 

way—is always a huge bonus! 

Aside from how you carry yourself and act at a wedding, there are two other things that can help turn bridesmaids 

always a huge hit! The couple, the family, and guests love it every time! 

I also create a surprise for the couple. I have my team member put the slideshow on a Playbook from 

presented nicely with a handwritten card from me congratulating them on their wedding and saying this is a small 
gift from me to them. Then, they have the slideshow that they can take with them on their honeymoon that they 
will rave about on social media. It’s a win-win for me.  

text the edited images to the couple and all the vendors. They all absolutely love this and share and rave over this 
like crazy. The bridesmaids will also notice this and it will be something they remember when they get married.

4. HOOK THE BRIDESMAIDS 
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5 Tips for a Successful Wedding | Justin Yoder
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Justin Yoder is the award-winning owner of Justin Yoder Studios based in Dallas, Texas. He 
is a professional photographer, educator and humanitarian. At age 16 he had his first image 
published and credits much of his success to being able to land clients like American Airlines, 
Chipotle and the Wounded Warrior Project within his first few years of business. 

justinyoderstudios.com 

5. BACK UP THE FILES IMMEDIATELY

I don’t want the whole case stolen if someone thinks there’s money in it). The backups stay there until I am 

experimenting with Amazon Photos. If you have a Prime account with Amazon, you have free unlimited photo 

On the way home from a wedding, if you stop for any reason, it’s important to keep your cards on you. I can’t 
tell you how many times I have heard of photographers’ cars getting broken into and their gear stolen with the 

to have to make that phone call. 

I hope these tips help make you a better photographer and make your weddings more successful. I would 

your weddings.  
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Capturing Moments on a Wedding Day | Raph Nogal
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Capturing Moments on a Wedding Day | Raph Nogal

After 11 years of photographing weddings, I see similarities in how I capture moments. There are 5 key things I 
do in order to help me and I want to share them with you below. It’s time to snap out of the routines and embrace 
the senses. 

1. BE CURIOUS

I believe wedding photography is a lot more involved than most other genres of photography. What I mean by 
“involved” is that a wedding day usually lasts 8—12 hours and has many moving parts and we, as photographers, 
are involved in it all throughout the day. We are also involved in the wedding much earlier. Our relationship with 
the client starts months before the big day and sometimes years earlier. As a boutique studio, I go out of my way 
to get to know my clients and what is important to them. How can I know what they love and want if I don’t ask? 
I’m genuinely curious. So on your next potential client meeting, make sure you ask. This is one of the most vital 
pieces of information because it will lead you to take images that are important to your clients. My curiosity has 
led me to photograph so many amazing moments, like the one below. 
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This is probably the most meaningful image I have taken to date. Prior to the wedding, I learned that the bride’s 
father was terminally ill. I knew this was a special situation and really wanted to document the relationship 
between the bride and her father. This moment was captured as the bride and her father embraced after the 
recessional at the beach of the church. It was moving to see the subtle embrace between them and how he held 
her hand. Three days later, I learned that her father had passed away and that’s when it really hit me—“Wow, we 
have so many opportunities to do something meaningful for our clients.” Had I not known the backstory, this 
moment may have been captured very differently or not been captured at all.
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Capturing Moments on a Wedding Day | Raph Nogal

2. BE MINDFUL

Being curious helps you succeed in this next step—being mindful and anticipating the action. Once you know 
what is important to your client, you’re able to focus and predict some of the action to photograph. It’s almost 

During this particular wedding day, the groom’s nephew was involved in the getting-ready portion of the day. I 
took the time to ask if he’s been walking and was told “not yet.” I kept that in mind as I photographed them. To 
get the photo above, I was seeing that his nephew was standing and was excited about the commotion of the day. 

steps. How amazing?
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Capturing Moments on a Wedding Day | Raph Nogal

3. BE PRESENT

Being present means not just being there physically, but also emotionally, and in the right headspace. Trying 

as a photographer—it becomes more personal. Being present and observing family dynamics also gives you 
perspective. It may reveal relationships between family members, between siblings, between the wedding party, 
and friends. This information can help you capture some amazing moments for your clients.  

and anticipating what he might do, and being present, allowed me to capture this moment. Throughout the day, 

started walking towards the groom, I made sure that I focused my attention on the groom’s reaction.
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Capturing Moments on a Wedding Day | Raph Nogal

4. BE IN CHARGE

Being in charge may initially sound counterintuitive to capturing moments, because you may think of moments 
as being 100% organic. I don’t believe that is the case. There are times during a wedding where if you left things 
to chance, things may not happen, or you may not have the opportunity to capture certain moments. Sometimes 
being in charge allows you to control the situation—not set it up or fake it, but rather control it so that it will 
allow for organic things to unfold. 

for them to exit the church. People were excited and scattered all over the place. By being in charge I was able 
to control where the couple would come out and prep everybody to make sure they threw the rice at the right 
time. Being in charge allowed me to get everybody ready and allowed me to have the composition and timing 
that I wanted for the shot. 
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Capturing Moments on a Wedding Day | Raph Nogal

Raph Nogal is a professional wedding photographer of 11 years based in Toronto, Ontario, 
Canada. Raph’s style can be best described as a fusion between photojournalism and  
art-focused editorial photography. Best known for his creative off-camera lighting approach, 
Raph is an active photographer, educator and speaker, and proud ambassador of Profoto Canada, 
MagMod, Vision Art, Sprout Studio, and Spider Holster, and is an Educational Ambassador for SLR 
Lounge. As a 24-time recipient of WPPI Honours of Excellence Awards, Raph is also a Fearless 
Photographers Award winner, Shutterfest Print Comp Award winner, as well as a PPOC Winner and 
Loan Collection participant in National and Regional Image Salons in Canada.

raphnogal.com
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5. BE FLEXIBLE

Sometimes as photographers we become a little bit obsessive when it comes to composition, lighting, and making 

planned and you will not have control of every aspect of the wedding. You may not always know all the ins and 
outs of the family dynamic and you will miss anticipating something that leads to the exact moment that you’re 

the cause of not capturing a beautiful moment that may mean the world to your client. 

The photo below was taken during a moment between moments. I was giving the clients some direction for a few 
more posed shots, and once I got the shots I needed I just told them to relax and wait for me to grab another lens. 
They started talking to each other and eventually she leaned into his chest and closed her eyes for a few seconds. 

without them even noticing just before I went to the camera bag to change the lens.

. 

Keep these 5 tips in mind on your next wedding day. You will be surprised how they can change your perspective.

The
Professional’s 

Source

www.BandH.com
Where you will fi nd information 

on over 400,000 items

Visit Our SuperStore
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Call an Expert Today
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Shipping

on orders over $49*
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How to Shoot an Engagement Session | Vanessa Joy

Everyone has their own creative process. It’s all well and good when you’re shooting and feeling inspired and 

As much as we’d all love to only photograph our subjects when we’re feeling artsy, being a professional  

produce the same results as when we’re at our photographic best. At least to the point where our clients can  
tell anyway.

Here’s my method and process of how I shoot my typical engagement session and how I interact with my clients 

have the best natural light and can maybe even snag a sunset or twilight picture or two. 
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How to Shoot an Engagement Session | Vanessa Joy

a Canon 135mm 2.0 lens so that the distance between us is more comfortable than shooting with say a 50mm 
lens right off the bat. 

away from me, I won’t direct them too much because that’s when I’m usually solidifying my settings and the 

affection than just holding hands.
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1.2 lens and photograph a bit tighter and capture some more of the details. Photographing the bride, I’ll have her 

helps. Videographers don’t want to shoot someone standing still. It’s just not interesting. Learn to add movement 
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How to Shoot an Engagement Session | Vanessa Joy

Anything to deliver a good variety to my clients. After all, a goal of mine is to provide them with an engagement 

Im
a

g
e

 ©
  

V
a

n
e

ss
a

 J
o

y

Im
a

g
e

 ©
  

V
a

n
e

ss
a

 J
o

y

GET CREATIVE



14
6
   

S
h

u
tt

er
 M

ag
az

in
e 

. M
ay

 2
0

20

14
7 

  b
eh

in
d

th
es

h
u

tt
er

.c
o

m

How to Shoot an Engagement Session | Vanessa Joy

Im
a

g
e

 ©
  

V
a

n
e

ss
a

 J
o

y

LEARN MORE.
youtube.com/btsShutterMagazine
Click here or check us out at

vanessajoy.com

Vanessa Joy has been a professional wedding photographer in New Jersey since 2002, and an 
influencer in the photographic community for years. Since starting VanessaJoy.com in 2008, 
she has taught photographers around the globe at almost every major platform in the industry 
(LearnPhotoVideo.com). Vanessa has been recognized for her talent and business sense at the 
renowned industry events CreativeLIVE, Clickin’ Moms, WPPI and ShutterFest. Her peers love 
her informative, open-book style of teaching.

Even though my style is a little bit more light and airy and soft and romantic, I do try and step out of that style 

reason not to experiment. Same goes for you. Every shoot, after you get what you’ve promised your clients, 

have for you! 
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Transitioning from Shoot & Burn to IPS | Gary & Kim Evans

1. CLIENT EXPERIENCE

How you treat your clients, how you communicate with them, how you speak to them, and your overall brand 
message combines to provide your client experience. Without providing our couples with that next step of prints 
and albums, we were unknowingly pushing our beloved clients off a cliff at the end of our wedding process, 

they liked with their images after the wedding. In hindsight, we were really doing them a disservice. 

When we revamped our client experience, we tried to put ourselves in their shoes. How could we anticipate 
questions, provide more information, make them feel valued, and give them all the attention that they deserved? 
A huge part of our client experience is our studio. 

Our studio is a dedicated space we have for our clients. It’s stylish, professional, intimate, and located in a 
beautiful historic building downtown. It’s a space for private meetings with our clients where they can view our 
artwork and albums and it’s where we conduct our IPS sessions. There are no kids, no distractions, and we can 
focus on our clients and provide them with an experience that isn’t offered in our area.

Another tool to provide our clients with a superior experience is our client management software. We’re big 

and helps us stay organized. We’re not simply sending contracts and invoices, but there are intro emails that 
set expectations, thank you’s, scheduling, and many other messages that would fall to the wayside if you were 
trying to keep it all happening on your own. Our clients don’t need to print or scan—they can digitally sign 
their contract and submit payments. And, we can reply to leads quickly on the go. All making our business run 

My business was at a turning point. I would often 
say to Kim, “We need more weddings, we need 
more weddings, we need to make more money!” 
Was booking more weddings the only way to make 
more money? I was already so busy! Maxing out 
the peak times of the year with weddings and 
being bogged down with editing... There had to 
be something more that we could do. What was I 

to where we are now.

By transforming our business from a shoot and burn 
model to a full service IPS photography studio, we 

$195K in one year. I’m not going to lie to you—
it was hard work. We revamped our logo, our 
website, thought about what we could do to elevate 
our client experience, and most importantly, added 
IPS. We realized we were leaving so much money 
on the table and we weren’t helping our clients 
where they needed it most. Here are 6 actions we 
took to get the ball rolling.

afterbefore
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Transitioning from Shoot & Burn to IPS | Gary & Kim Evans

Running a business is hard. Without knowing your cost of goods and pricing accordingly, running an effective 

have been developed with those numbers in mind and we don’t stray from them. We know what we’re worth and 

way to reach your dreams.

When we’re shooting our couples, either at a wedding or on an engagement shoot, we’re actively thinking about 
what the end image is going to look like. We’re trying to create next-level artwork that will be impossible to say 
no to. It needs to be big, bold, and dramatic. Our signature portraits encompass all of these and are unlike anyone 
else’s style in our area. So many couples comment that they haven’t seen anything like our signature images 
before. They can’t wait to see them and really look forward to seeing them as soon as they’re in their viewing. 
It’s always the image that we showcase on the big screen when they come into the studio, and they are dazzled, 
often not believing it’s them.

When we’re shooting a wedding, we know we’ll be designing an album afterwards, so we actively shoot images 

about what will never make it in there. We get everything we need to be able to design a beautiful album that 
tells the story of the client’s day: the details, the bridal party, family formals, and our main priority is always  
the couple. 
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2. COST OF GOODS

3. SHOOT TO PRINT
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Transitioning from Shoot & Burn to IPS | Gary & Kim Evans

4. GETTING STARTED WITH WARM IPS

If you don’t have IPS as a part of your business process with your couples and want to start, I suggest you check 
in on your past clients. Major lightbulbs went off when we ran into a past couple at a bridal show. We had a 
chat and we asked them what they did with their wedding photos. The answer was shocking. Nothing. They 
didn’t know where to start, where to go, and just didn’t get around to it after the married life took over. This 
conversation drove us to reach out to a few more couples from the previous two years. We got a lot of similar 
answers. In fact, there was only one couple that we contacted that had actually printed some photos. It was a little 
disheartening that I spent so many hours editing the wedding for nothing to be done with the images apart from 
a few Facebook and Instagram posts.

Having never done IPS before, we thought of a perfect way to start and get Kim’s feet wet. It was winter in 
 had clients. In fact, we had 

amazing clients who were actually already fans of ours. And we knew from speaking with a handful of them that 
it was rare to have a past couple who had actually done anything with their wedding images.

We designed an email, highlighted our products, personalized each email with their wedding photos and an 
image of an album with their photo on the cover, and invited them into the studio to view our samples.

For the couples that chose to come in, we knew they were interested in either prints or an album (or sometimes 
both). They were already interested and by coming to view the products had committed in their minds to  
purchase something.

Were we nervous? Hell yes. But we loaded their weddings into N-Vu (our IPS software) and hoped for the best. 
We had a great catch up about what they had been doing since the wedding and we showed off our new products, 
took them through our vision, and talked about what would work in their homes and how they had always hoped 

We provided a service to our clients that was an extension of the already great job we had done for them. And 
they thanked us for it.
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Transitioning from Shoot & Burn to IPS | Gary & Kim Evans

5. SUGGESTIVE SELLING THROUGH YOUR PROCESS

We took a lot of care choosing our print and album suppliers. We went through a lot of samples before settling 

our products and we can’t keep that excitement to ourselves.

Throughout our interactions, meetings, shoots, and emails, we are always talking about printing. Our mission is 
sent out in emails before they sit down for their initial meeting with me. We talk about helping them create their 

home, not just for them but also for future generations. 

When we are shooting with them, we’re talking about their home and where they would display the images, and 
having some fun creating that “one for the wall” while we’re out on location. We’re building their excitement to 
come into the studio to see their images—where they’re going to view and order their favourites. We reiterate 
the words “view” and “order” many times throughout our interactions so that it comes as no surprise when they 
come into the studio.

Throughout their process, we’re working with them and talking about our prints, albums, and how awesome it’s 
going to be to have them in their home. They are coming into each sales session excited and ready to choose a 
package to buy.
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Transitioning from Shoot & Burn to IPS | Gary & Kim Evans

After a whirlwind romance that brought Gary to Canada from Wales, Gary + Kim have been 
building Gary Evans Photography into the full service, luxury photography studio that you see 
today. As a husband and wife team, Gary is the Principal Shooter and Visionary, Kim is the Studio 
Manager, Social Media + Website guru and IPS Whiz. Together they are driving their business 
forward, all while balancing a hectic home life with two boys.

garyevansphotography.ca

6. OUTSOURCE WHAT YOU CAN

If you’re going to start offering IPS, maybe with a partner or on your own, the one thing you will need is 
more time. By adding IPS to your business model you’re going to be adding more client meetings and those 
meetings can end up being quite long. The downside is time, but the upside is that you will add to your income 

way to keep your turnaround times quick and give yourself more time in the day. Working with a great team like 
Evolve is a lifesaver and I wholeheartedly recommend it. As a business it’s crucial to spend your valuable time on 

of ourselves, a business partner that gives us back the time we need to be effective. No one likes accounting, 
right? So you have an accountant. Outsourcing your editing is like that. If you can make more by outsourcing 
your editing, why wouldn’t you?
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10 Tips for Wedding Photojournalism | Matthew Sowa
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10 Tips for Wedding Photojournalism | Matthew Sowa

When I started my career as a New York wedding photographer in 2004, I was told that wedding photography 
is not about me. It’s about seeing the world through the eyes of the bride and groom. They’ve designed this 
beautiful day—their perfect vision. My role is to apply creativity and style to create images that document and 
honor the scene, mood, and emotions that they’ve created.

photojournalist, and portrait photographer—capturing every aspect of the day. I stylize the central focus and 
pay close attention to the details and background of every photo. Each image should be interesting, fresh, and  
well-composed. I strive to always create pictures that have movement, power of emotion, and modern style.

PHOTOJOURNALISM

Wedding photography is about the bride and groom: capturing their memories rather than simply documenting 
the day. Many couples want to capture their candid, spontaneous moments with a journalistic style.

I would love for all of these images to happen organically and without any participation from the subjects; 
however, it’s not always possible. I’ll let you in on a trade secret: pure wedding photojournalism does not 
exist. The wedding day is a short time frame, and some stylistic direction is required to cover it properly. When 
expressive moments don’t happen on their own, some interaction with the subjects can create opportunities for 
great authentic photos.

THE MAGIC MOMENT
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In the image above, I used available wedding props to evoke emotions. It was a rainy October day in Long Beach, 
New York, and I had given my bridal party a bottle of champagne to celebrate during the preparation. When I 
stepped out to photograph them in the windows, I saw a local surfer running by and used the opportunity to layer 

got the shot I was dreaming about.

I want every image to be real and with as little intrusion as possible, but sometimes a little interference is called 
for. I call this interactive photojournalism. I interacted with the bridal party to get my shot; however, their 
expressions were authentic and the surfer was spontaneous. The resulting image perfectly captured the mood of 
the day.
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10 Tips for Wedding Photojournalism | Matthew Sowa

1. USE THE RIGHT TOOLS

Get your cameras set up properly. Use a wide aperture to isolate the magic in the image. Focus is a tool used 
in the photojournalistic style to draw attention to the relevant subject. If you’re an inexperienced wedding 
photographer, I recommend using the smallest aperture possible to get a wide range of focus. The narrow depth 

using manual settings so that you can capture the moment right when it happens.

2. PAY ATTENTION

look are fantastic, but sometimes the very best moments happen when you least expect them. Before, after, and 
in-between these planned moments, stay alert—I guarantee something amazing will happen, and you won’t want 
to miss it. Be like a hunter; trust your instinct, move quickly, and wait for your perfect shot to emerge.
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10 Tips for Wedding Photojournalism | Matthew Sowa

4. SHOOT FROM YOUR BOOTS

Putting your camera on the ground and taking shots of your subject from that low angle introduces a completely 

perspective, add interesting foregrounds to shots, and even capture a few surprising subjects along the way.

5....OR FROM THE TOP

3. CREATE LAYERS

You can use multiple elements in a shot that has front to back sharpness to really shout your message, or you can 
have one main subject and use more subtle layers in the foreground and background. This usually means using a 
little bit of creative blur so the viewer can still see the other elements, but understand that the photo is still mainly 
about the object/person who’s sharp.
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6. USE MOVEMENT

7. FOLLOW THE FUN!

The bride and groom will want to remember the fun and laughs that were had at their wedding. Dancing, drinks, 
and laughs... follow the fun! Don’t forget to include several candid shots of bridal party members—the best time 
to do this is often when they are having fun.Im
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10 Tips for Wedding Photojournalism | Matthew Sowa

8. BE INVISIBLE

Being invisible may sound like I’m advising you to hide that you’re taking photos, but this isn’t the case. Feel 
free to photograph openly, leaving the opportunity for the photographed people to acknowledge that you are 

9. USE THE RIGHT CHOICE OF LENSES 
BASED ON LOCATION

Different times of the day call for different lenses 
and techniques. For example, during the bride’s 
preparation, I typically use 35mm 1.4, 85mm 1.4, and 
24-70mm 2.8 lenses, and I take most of these images 
with as open of an aperture as possible. This creates a 
gentle blur in the background, eliminating unnecessary 
subjects in the room, and allows the focus to remain on 
the bride.

10. PLANNING IS KEY

The most important thing to bring to your work as a photojournalist is careful planning. If you haven’t been to the 
location in advance, you might not choose the right equipment or be in the right spot when something important 
happens. Visit the location in advance or arrive early to shoot a bit before your couple arrives to be sure you’ll 
create images that are timeless, compelling, and true.
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10 Tips for Wedding Photojournalism | Matthew Sowa

CREATIVITY IS ALL ABOUT CAPTURING THE MOOD

I love that when I start a wedding, I never know what to expect. Every couple is different and every wedding 
presents new opportunities. Creativity is all about highlighting people’s expressions, mannerisms, or interactions. 
Lighting, shadows, other subjects, or other elements can also make the image unique. Everything is based on 
using what you have in the location. I look into my psyche and trust my instinct to get the shoot I want.

Born in Poland, Matthew Sowa earned a degree in photography from the Warsaw College of 
Photography and has received additional training and study at the Institute of Art Photography 
in Ostrava, Czech Republic. Matthew has been a New York City-based wedding photographer 
for over 15 years, covering more than 800 weddings. His documentary approach is balanced 
by contemporary portraits created in dramatic style. He infuses his work with enthusiasm, 
spontaneity and a fresh original eye. His passion and unique perspective are reflected in strong 
and simple compositions, very often in black & white form, leaving nothing between the content 
and the viewer.
matthewsowaphotography.com

A FEW WORDS ABOUT POST-PRODUCTION

I miss old darkroom processing techniques. I’ve spent a lot of time in the past processing B&W images with 

effect presets, and this is one of the reasons I don’t overuse them. While presets can add to an image, I believe 
that less is more. I prefer my images to be as simple as possible, without distractions, allowing the viewer to see 
and appreciate the realism. If you overuse presets, you are taking away a lot of the real world.

Whether you’re a novice or a professional photographer, documenting a wedding all is about the couple. Know 
the location, pay attention to your subjects, and be open to creative opportunities to capture the essence of  
the day.
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Inspiration can come when you least expect 

it. As photographers, we are visual artists.  

We  express ourselves through our camera  

and the images we create. Inspirations 

represents a  sampling of our industry and the 

vision of  professional photographers from 

around the world. 

Congratulations to all our featured artists. Be 

inspired and create something that is you.

Sal Cincotta, Publisher
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awesome light—all without breaking the bank!

Lastolite 3’x3’ diffusion scrim

Sunbounce Micro Mini 



20
4

   
S

h
u

tt
er

 M
ag

az
in

e 
. M

ay
 2

0
20

20
5 

  b
eh

in
d

th
es

h
u

tt
er

.c
o

m

Low-Cost Location Lighting | Michael Corsentino

Im
a

g
e

 ©
 M

ic
h

ae
l C

o
rs

en
ti

n
o

PREPARE

FIGURE OUT WHAT WORKS

Im
a

g
e

 ©
 M

ic
h

ae
l C

o
rs

en
ti

n
o



20
6
   

S
h

u
tt

er
 M

ag
az

in
e 

. M
ay

 2
0

20

20
7 

  b
eh

in
d

th
es

h
u

tt
er

.c
o

m

Low-Cost Location Lighting | Michael Corsentino

Michael Corsentino is an Orlando, Florida-based editorial fashion and portrait photographer. In 
addition to his busy shooting schedule, Michael is a passionate educator, teaching workshops 
domestically and internationally. He is an author of two books, writes a monthly lighting 
column for Shutter Magazine and is a regular contributor to Photoshop User magazine and 
JointheBreed.com.

michaelcorsentino.com

LEARN MORE.
youtube.com/btsShutterMagazine
Click here or check us out at
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gear canon eos r
rf 85mm f1.2

exposure
lighting
location

f/1.2 @ 1/3200 iso 160
profoto a1 
new orleans

website www.michaelanthonyphotography.com
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